CDR is a registered trademark of Sirona Dental, Inc.
Sirona Dental, Inc. products are covered by one or more of the following US Patents.

Wired CDR® Sensors US 5,434,418; US 6,069,935; US 6,134,298

Wired and Wireless CDR® Sensors (Both) US 5,912,942; US 5,841,126; US 6,456,326; US 6,549,235; US 6,570,617; US 6,744,868; US 7,369,166


USBCAM® US 6,002,424; US 5,908,294

Positioning Systems US 6,811,312

Schick WiFi US 7,090,395; 6,091,982

Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks. Where those designations appear in this document, and Sirona Dental, Inc. was aware of a trademark claim, the designations have been printed in caps or initial caps.

December 14, 2012

Printed in the United States of America

This document was originally prepared in English
Contents

1. Overview .................................................................................................................. 1
   1.1. Purpose .................................................................................................................. 1
   1.2. Indications for Use ............................................................................................... 1
   1.3. System Description ............................................................................................... 1
   1.4. PC Workstation Description .................................................................................. 2

2. Hardware ................................................................................................................... 3
   2.1. Connecting Cables to the CDR USB Remote HS .................................................... 3
   2.2. Installing the CDR USB Remote HS Holder .......................................................... 4

3. Software .................................................................................................................. 6
   3.1. What You Will Need to Complete this Section ....................................................... 6
   3.2. Before You Start Installing Software .................................................................... 6
   3.3. Setup with Windows 7 ......................................................................................... 7
   3.4. Using the CDR USB Remote Utility ..................................................................... 11

4. LED Indicators ........................................................................................................ 15
   4.1. Understanding CDR USB Remote HS Indications .................................................. 15

5. Operation .................................................................................................................. 16
   5.1. Operating the Device ............................................................................................ 16
   5.2. Using CDR USB Remote HS with CDR DICOM .................................................... 17
   5.3. Acquiring X-ray Images with the Footpedal ......................................................... 19
   5.4. Acquiring X-ray Images with Keyboard Shortcuts ................................................ 19

6. Protective Measures ............................................................................................... 20
   6.1. Cleaning .............................................................................................................. 20

7. Maintenance ............................................................................................................. 21
   7.1. Visual Inspection .................................................................................................. 21
   7.2. Periodic Maintenance ......................................................................................... 21

Appendix A. Reference ................................................................................................. 22
   A-1. Removal and Replacement Procedures .............................................................. 22
   A-2. Summary of Specifications .................................................................................. 22
   A-3. Leakage Current Statement ................................................................................. 23
   A-4. EMC Tables ....................................................................................................... 24

Appendix B. Troubleshooting Tips .............................................................................. 28
   B-1. Introduction ....................................................................................................... 28
   B-2. Troubleshooting ............................................................................................... 28

Index ............................................................................................................................ 29
List of Figures

Figure 1. CDR USB Remote HS Cable Connections ................................................................. 3
Figure 2. CDR USB Remote HS Holder .................................................................................. 4
Figure 3. Device Manager on Windows 7 Desktop ................................................................. 8
Figure 4. Device Manager ...................................................................................................... 8
Figure 5. Search for Driver Software ................................................................................... 9
Figure 6. Browse Computer for Driver Software ................................................................. 9
Figure 7. Driver Software Update Successful ...................................................................... 10
Figure 8. CDR USB Remote HS LED and Connector Views .................................................. 15

List of Tables

Table 1. Description of CDR USB Remote HS Cable Connections ....................................... 3
Table 2. CDR USB Remote HS LED Indications .................................................................... 15
Table 3. Footpedal Actions ................................................................................................... 19
Table 4. Keyboard Shortcuts ................................................................................................. 19
Table 5. Specifications .......................................................................................................... 22
Table 6. Guidance and Manufacturer's Declaration - Electromagnetic Emissions ............... 24
Table 7. Guidance and Manufacturer's Declaration - Electromagnetic Immunity ............... 25
Table 8. Recommended Separation Distance Between Portable and Mobile RF Communications Equipment and the CDR USB Remote HS ................................................................. 27
Table 9. ................................................................................................................................. 28
Table 10. Troubleshooting Table ......................................................................................... 28
Safety Issues

Check CDR USB Remote HS before Using It

There are no customer-serviceable components in the CDR USB Remote HS. However, before each usage, check the outer surface of the CDR USB Remote HS for any signs of physical damage or defect. The surface of the CDR USB Remote HS should have a smooth finish, with no evidence of chipping or damage. If detected, contact your local distributor of Sirona Dental products for further instructions.

To help ensure proper hygiene and to protect against infectious disease, refer to the “Protective Measures” section of this document and observe all device cleaning and patient protection recommendations specified there.

Operate the CDR USB Remote HS as Directed

Always use the CDR USB Remote HS in accordance with the directions and recommendations contained in this User Guide. Do not attempt to modify the CDR USB Remote HS or use it in system configurations not specified in this document.

Do Not Touch Exposed Connectors on Non-Medical Equipment and the Patient at the Same Time

When the CDR USB Remote HS is in use, avoid touching exposed connectors on non-medical electrical equipment and the patient at the same time. The human body is capable of conducting electrical current and may cause a shock hazard to patients if appropriate safety practices are not observed.

Apply Recommended Procedures for Cleaning the Equipment

Safe and proper operation of the equipment requires following a regular schedule of preventive maintenance. Refer to “Protective Measures” in this document for details.

Do Not Connect Items that are Not Part of the System

Only items specified for use with the CDR USB Remote HS device are to be connected to it. The device should not be used adjacent to other equipment that is not part of the system. If, however, use with adjacent equipment is necessary, normal operation should be observed and verified in that configuration.
Installers to Ensure that CDR USB Remote HS Operates Optimally

Installers must ensure that the CDR USB Remote HS provides the user with the optimal use of the equipment. This includes, but is not limited to, ensuring the system operates as described in this document. Installers must also ensure that the system presents no physical obstacles or hazards during operation and when not in use. To verify this requirement, installers shall confirm that the CDR USB Remote HS is installed as described in this User Guide and shall perform the appropriate procedures therein.

Ensure Proper System and PC Workstation Installation and Operation

The CDR USB Remote HS has been determined to be in accordance with international safety standards and is deemed suitable for use within the patient area, which extends from the patient for a distance of 5 feet (1.5m). To comply with these standards, do not operate non-medical equipment (such as a PC workstation) inside the patient area. Outside the patient area, the presence of approved non-medical grade equipment and Listed / Approved / certified Information technology Equipment (ITE) computer equipment is acceptable.

The host computer (PC workstation) should be CE-approved and conform with the Low Voltage [73/23/EC] and EMC Directive [89/336/ERC]. Also, to help ensure optimal performance, ensure that all software programs residing on the workstation are virus-free and have been adequately tested so they will not impact imaging applications after installation.

RF Interference Considerations

Although the CDR USB Remote HS equipment is designed to provide a reasonable degree of protection from electromagnetic interference, according to IEC International regulations, it must be installed at an adequate distance from electricity transformer rooms, static continuity units, two-way amateur radios and cellular phones. To ensure proper operation, the latter (meaning, electricity transformer rooms, static continuity units, two-way amateur radios and cellular phones) can be used only at a minimum distance of 5 feet (1.5m) from any part of the CDR USB Remote HS.

Any instrumentation or equipment for professional use located near the CDR USB Remote HS must conform to Electromagnetic Compatibility regulations, to which the EMC tables in this document’s Appendix serve as guidance. Non-conforming equipment, with known poor immunity to electromagnetic fields, may not operate properly unless they are installed at a distance of at least 10 feet (3m) and supplied by a dedicated electrical line.
Only Dentists or Authorized Designees Are Permitted to Operate the System

To ensure the correct use of the CDR USB HS device in a clinical environment, for purposes that correspond to its intended design and application, only dentists, or their designees, are authorized to operate the system.

Always Use Sheaths with Sensors

Use protective sheaths every time a Sensor is used. Never use a damaged sheath. Always dispose of the sheath after every patient.

Protective sheaths are single-use devices and must not be reused under any circumstance. Reuse of single-use devices/instruments may cause them to become contaminated, compromise their intended function, and result in patient and user infection, injury and/or illness.

Product Manuals from Sirona Dental

The contents of this manual are subject to change without prior notice. For the latest version of this user guide and other product manuals from Sirona Dental, please consult our website: www.schickbysirona.com.
# Explanation of Symbols

Refer to the following table for symbols found on the Remote HS itself, on packaging in which the equipment is shipped, or in the text of this or other documents provided with the system.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>Indicates Class II equipment in accordance with applicable medical device safety standards (IEC/EN/UL 60601-1)</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates Type BF equipment in accordance with applicable medical device safety standards (IEC/EN/UL 60601-1)</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates an attention to users to consult accompanying documents (this User Guide) for more information</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Conforms to European Union Medical Devices Directive (MDD) 93/42/EEC</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates that this product meets North American safety standards. The ETL mark is a Nationally Recognized Testing Lab (NRTL) marking and indicates conformance with UL 60601-1 and CAN/CSA STD C22.2 NO 601.1-M90</td>
</tr>
<tr>
<td>![Symbol]</td>
<td>Indicates that in the European Union, at the end of product life this device must be disposed of in accordance with the requirements of the Waste Electrical and Electronic Equipment (WEEE) directive 2002/96/EC</td>
</tr>
</tbody>
</table>

## Label Location

The logo and the following label can be found on the CDR USB Remote HS.

```
Conforms to UL Std. 60601-1.
Certified to CAN CSA C22.2 NO.601.1

CDR USB REMOTE HS
Input: +5 V DC @ 250 mA
P/N B2250100  MFR: XX/XXXX  S/N: XXXXX
SIRONA DENTAL, INC. L.I.C., NY 11101
```
Waste Electrical and Electronic Equipment

Background

The European Union’s Waste Electrical and Electronic Equipment (WEEE) Directive (2002/96/EC) has been implemented in member states as of August 13, 2005. This directive, which seeks to reduce the waste of electrical and electronic equipment through re-use, recycling, and recovery, imposes several requirements on producers. Sirona Dental and its Dealers are committed to complying with the Directive.

WEEE Marking

All Sirona Dental products subject to the WEEE Directive and shipped after August 13, 2005 will be compliant with the WEEE marking requirements. These products will be identified with the “crossed-out wheeled bin” WEEE symbol shown below, as defined in European Standard EN 50419, and in accordance with WEEE Directive 2002/96/EC.

![Crossed-out wheeled bin symbol](image)

This “crossed-out wheeled bin” symbol on the product or on its packaging indicates that this product must not be disposed of with other unsorted municipal waste. Instead, it is user’s responsibility to dispose of EE waste equipment by handing it over to a designated collection point for the reuse or recycling of waste electrical and electronic equipment. The separate collection and reuse or recycling of Electrical & Electronic waste equipment will help to conserve natural resources and ensure that it is recycled in a manner that protects the environment and human health. For more information about where you can drop off your waste equipment for recycling, please contact your local officials.

Reporting

According to the WEEE Directive, Sirona Dental or its Dealers will ensure that information needed to calculate the financial obligations with respect to EEE products will be provided as required.
WEEE from Users other than Private Households

According to the WEEE Directive, Sirona Dental or its Dealers will fulfill its obligations for the management of WEEE from users other than private households.

Furthermore, as required by the WEEE Directive, in order to determine unequivocally when the equipment was put on the market, the manufacturer’s date is placed on the equipment.

Information for Reuse Centers, Treatment and Recycling Facilities

As required by the WEEE Directive, Sirona Dental or its Dealers will provide reuse, treatment, and recycling information for each type of new EEE put on the market within one year of the date in which the equipment is put on the market.

Information will include the different EEE components and materials as well as the location of substances in these items. The information will be provided as a printed document or in electronic media (on CD-ROM or by web download, for example)
CDR USB Remote HS

CDR USB Remote HS with Sensor and USB Cable Connected
1. Overview

1.1. Purpose

The CDR USB Remote HS (High-Speed) (Schick P/N B2250100) is the interface for standard CDR Sensors and is compliant with the latest USB version 2.0 specification. Adding the CDR USB Remote HS to your office provides the following advantages:

- Fast image acquisition-to-display time
- Works with all standard CDR sensors
- Digital output over high-speed USB 2.0
- Upgrade utility supports in-office firmware / CPLD updates
- Built-in sensor emulator for system self-test.

1.2. Indications for Use

The CDR USB Remote HS is to be used as part of an intraoral image acquisition system and is indicated for individuals requiring intraoral dental examinations.

1.3. System Description

The CDR USB Remote HS is connected by USB A-B cable (supplied separately) to a compatible PC workstation. The workstation runs Windows 7, Windows Vista, or Windows XP and also provides the power source for the device. Additional details on the PC workstation may be found in Section 1.4. Additional details on the USB cable may be found in Section 2.1.

Support for the CDR USB Remote HS is provided by compatible software programs such as CDR DICOM for Windows 3.5 SR-1 and higher. For other custom applications, a programmer’s guide is available.

The CDR USB Remote HS includes a detachable holder so the device can be mounted either by screws to a wall or other stable surface. Details on installing the CDR USB Remote HS holder may be found in Section 2.2.
1.4. PC Workstation Description

The PC workstation connects to the CDR USB Remote HS via USB cable (supplied separately) and serves as the host for CDR DICOM or other compatible imaging software products. The workstation provides the capability to display, manipulate, store, and print images acquired from CDR Sensors.

Getting the best results from your CDR system begins with having a computer system suitable for capturing and displaying intraoral images. For optimum performance, we recommend the following:

1. Compatible operating systems
   - Windows 7 Home, Premium, Business, or Ultimate (all 32- or 64-bit) Windows XP Pro and XP Pro x64 Edition, Windows Vista and Vista x64 Edition

2. Compatible imaging applications
   - CDR DICOM for Windows 3.5 SR1 and higher, EagleSoft 14.0 and higher, and Patterson Imaging 14.0 and higher.

3. Pentium D processor or Intel Core2Duo processor

4. 2 GB RAM

5. 250 GB hard drive Raid Level 1 (practice-specific, depends on number of patients)

6. Intel USB chipset with at least 2 powered USB 2.0 ports (USB 1.1 also supported)
2. Hardware

2.1. Connecting Cables to the CDR USB Remote HS

**IMPORTANT!** Do not connect the CDR USB Remote HS and cable to your computer until after you have successfully run the setup program. Procedures for installing these files are supplied in Section 3, "Software."

The USB cable used with the device has a Series "A" USB plug on one side and a Series "B" USB plug on the other. The "A-type" plug connects to any available USB port on the computer. The "B-type" plug connects to the CDR USB Remote HS.

- B2250150 - 5 meter (16.5 feet)
- B2250151 - 2 meter (6.5 feet)
- B2250152 - 0.5 meter (1.6 feet)

An illustration of the CDR USB Remote HS is shown below in Figure 1. For a description of cable connections to the device, refer to Table 1.

![Figure 1. CDR USB Remote HS Cable Connections](image)

Table 1. Description of CDR USB Remote HS Cable Connections

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CDR Sensor</td>
</tr>
<tr>
<td>2</td>
<td>CDR Sensor cable edge-card connection</td>
</tr>
<tr>
<td>3</td>
<td>CDR USB Remote HS</td>
</tr>
<tr>
<td>4</td>
<td>USB cable connection (&quot;B&quot; connector end of USB cable connects here)</td>
</tr>
<tr>
<td>5</td>
<td>USB cable connection (&quot;A&quot; connector end of USB cable connects to PC)</td>
</tr>
</tbody>
</table>
2.2. Installing the CDR USB Remote HS Holder

The CDR USB Remote HS holder is designed for several mounting options: (1) Wall-mounted with fastening hardware, or (2) Attached to a wall or other acceptable bonding surface with Velcro adhesive. When installing your CDR USB Remote HS choose a location that offers easy access and visibility during patient exams.

![Figure 2. CDR USB Remote HS Holder](image)

2.2.1. Wall-Mounting Option (with Fasteners)

Install the holder by fastening it to a wall or other flat surface, as follows:

1. Remove the CDR USB Remote HS from its holder before performing this procedure.

2. Position the holder on a smooth stable flat surface. Using the holes on the back of the holder as guides, fasten the holder securely to the wall using 2 (#4 x 1-inch) dry wall anchors and / or screws (supplied) or other hardware appropriate to the mounting surface.
2.2.2. Wall-Mounting Option (with Adhesive)

Install the CDR USB Remote HS by attaching it with Velcro adhesive to a wall or other flat surface, as follows:

1. Remove the CDR USB Remote HS from its holder before performing this procedure.

2. Cut and trim a piece of Velcro adhesive (not supplied) to the size of the back of the Remote. Remove one half of the tape and attach it to the Remote.

3. Locate an accessible, stable, and flat surface for the Remote. Apply the other half of the Velcro adhesive in that location and attach the Remote securely.
3. Software

3.1. What You Will Need to Complete this Section

To expedite software installation, please have the following items available:

- CDR USB Remote HS CD
- CDR USB Remote HS
- USB 2.0 A-B Cable (supplied separately)

3.2. Before You Start Installing Software

**IMPORTANT! Please do not connect the CDR USB Remote HS and USB cable to your computer until after you have installed the device driver. Procedures for installing these files can be found on the following pages.**

The software component to accompany your CDR USB Remote HS installation consists of the CDR USB Remote HS device driver. You must install this driver successfully to ensure proper operation of your CDR USB Remote HS.

Installation may differ slightly between Windows operating systems, but the procedure included here for Windows 7 can be considered representative. If you're not sure which operating system is installed on your computer, right click on the My Computer icon on your desktop and select Properties (pressing the Windows Start (⏴) and Break keys will also display System Properties).
3.3. Setup with Windows 7

**NOTE:** These instructions assume that you have the following: Windows 7 Home, Premium, Business, or Ultimate (all 32-bit or 64-bit) and the CDR DICOM 4.5 CD or internet access to our website.

**STEP 1. INSTALLING THE DRIVER**

A. Close CDR DICOM 4.5 software if open.

B. Disconnect the USB cable from the CDR Remote HS Module.

C. Insert the CDR DICOM 4.5 CD and browse to the Hardware folder and double-click on CDR USB Remote HS Driver.msi, or download the Remote HS driver from our website.

D. When driver installation is complete, re-connect the USB cable to the CDR Remote HS Module. Make sure that the Sensor is connected also.

**STEP 2. UPDATING THE DRIVER**

A. Open the Windows Control Panel and navigate to System and Security > System > Device Manager.

A. Windows will indicate that the device was not successfully installed (*Figure 3*) and will be listed under Other devices (*Figure 4*).

B. Browse the list of items for the Other Devices node. Expand it if necessary and select the CDR Remote HS device item.

C. Right-click on the Unknown device and select “Update Driver Software” from the context menu.

D. Select “Browse my computer for driver software” (*Figure 5*).
Figure 3. Device Manager on Windows 7 Desktop

Figure 4. Device Manager
Figure 5. Search for Driver Software

Figure 6. Browse Computer for Driver Software
E. Click the Browse button and navigate to the CDR Remote HS driver: C:\Program Files\Schick Technologies\Shared Files\Drivers\CDR USB HS (Figure 6).

F. Click Next.

G. The message, “Windows has successfully installed your software driver software” is displayed (Figure 7).

H. Click Close

I. Repeat these steps on every workstation where the Remote HS Module is used.

Figure 7. Driver Software Update Successful
3.4. Using the CDR USB Remote Utility

3.4.1. Introduction

The CDR USB Remote Utility is installed during the CDR USB Remote HS Driver setup program. This tool can be used to accomplish the following:

- Perform Sensor Emulator test
- Perform CDR USB Remote HS firmware upgrades
- Perform CDR USB Remote HS CPLD upgrades

A sample screen of the CDR USB Remote Utility is shown below. (Please note that the version numbers shown in the picture below are examples only and may differ from those reported for your system.)
3.4.2. Sensor Emulator Test

The Sensor Emulator Test checks the connection between the Sensor, CDR USB Remote HS, and computer. A count of 10 test pattern images determines if there are problems that could impact the capabilities of your CDR system. A results window, indicating a Pass, Fail, Not Detected, or Not Supported message, is displayed at the end of testing.

- **Passed** — indicates that the CDR USB Remote HS is operating correctly.

- **Not Detected** — is typically the result of a poor or no connection at the CDR USB Remote HS or the Sensor. Check these connections and repeat the test.

- **Not Supported** — indicates that the currently connected Sensor does not support the Sensor Emulator implementation and cannot be tested with this function.

- **Failed** — may point to a problem with the CDR USB Remote HS device or the Sensor. Additional troubleshooting can be performed if another CDR USB Remote HS or Sensor is available. In this case, repeating the Sensor Emulator Test may help to identify a particular Sensor or CDR USB Remote HS that may be functioning incorrectly.

### Sensor Emulator Test Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Close the CDR DICOM or EagleSoft or Patterson Imaging program (if running).</td>
</tr>
<tr>
<td>2</td>
<td>Verify that CDR USB Remote HS and Sensor are connected to the computer.</td>
</tr>
<tr>
<td>3</td>
<td>Start the CDR USB Remote HS Utility (Start &gt; All Programs &gt; CDR DICOM for Windows &gt; CDR USB Remote HS Utility).</td>
</tr>
<tr>
<td>4</td>
<td>Click Tools &gt; Sensor Emulator Test.</td>
</tr>
<tr>
<td>5</td>
<td>Click Close to exit this test.</td>
</tr>
<tr>
<td>6</td>
<td>Click File &gt; Exit to close the utility.</td>
</tr>
</tbody>
</table>
3.4.3. Firmware Upgrade

Field updates to the CDR USB Remote HS can be accomplished by installing new firmware.

When new firmware is available, it may be provided with a software release and becomes part of the update to your existing system.

In the event you are prompted to upgrade CDR USB Remote HS firmware, perform the steps provided below.

---

**Firmware Upgrade Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Close the CDR DICOM or EagleSoft or Patterson Imaging program (if running).</td>
</tr>
<tr>
<td>2</td>
<td>Verify that CDR USB Remote HS is connected to the computer.</td>
</tr>
<tr>
<td>3</td>
<td>Start the CDR USB Remote HS Utility (Start &gt; All Programs &gt; CDR DICOM for Windows &gt; CDR USB Remote HS Utility).</td>
</tr>
<tr>
<td>4</td>
<td>If the firmware version number is shown in red, click the Upgrade Firmware button to upgrade. The firmware version number will change to green numbers when the upgrade is completed successfully.</td>
</tr>
<tr>
<td>5</td>
<td>Verify that the firmware version number is shown in green. If not, please contact your distributor of Sirona Dental products for additional information.</td>
</tr>
</tbody>
</table>
3.4.4. CPLD Upgrade

New resources can also be programmed to the Complex Programmable Logic Device (CPLD) inside the CDR USB Remote HS.

When a new CPLD upgrade is available, it may be provided with a software release and becomes part of the update to your existing system.

In the event you are prompted to upgrade CDR USB Remote HS firmware, perform the steps provided below.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Close the CDR DICOM or EagleSoft or Patterson Imaging program (if running).</td>
</tr>
<tr>
<td>2</td>
<td>Verify that CDR USB Remote HS is connected to the computer.</td>
</tr>
<tr>
<td>3</td>
<td>Start the CDR USB Remote HS Utility (Start &gt; All Programs &gt; CDR DICOM for Windows &gt; CDR USB Remote HS Utility).</td>
</tr>
<tr>
<td>4</td>
<td>If the CPLD version number is shown in red, click the Upgrade CPLD button to upgrade. The CPLD version number will change to green numbers when the upgrade is completed successfully.</td>
</tr>
<tr>
<td>5</td>
<td>Verify that the CPLD version number is shown in green. If not, please contact your distributor of Sirona Dental products for additional information.</td>
</tr>
</tbody>
</table>
4. LED Indicators

4.1. Understanding CDR USB Remote HS Indications

The CDR USB Remote HS has two LED indicators (amber and green) for reporting its functional status. Customers familiar with other USB Remote Modules from Sirona Dental will find that LED indications on the CDR USB Remote HS are identical.

The location and description of the LEDs is shown in Figure 8 and described in Table 2.

![CDR USB Remote HS LED and Connector Views](image)

**Figure 8. CDR USB Remote HS LED and Connector Views**

<table>
<thead>
<tr>
<th>Action</th>
<th>Green LED (P) Power</th>
<th>Amber LED (S) Status</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR DICOM not running</td>
<td>OFF</td>
<td>OFF</td>
<td>Sensor connected or USB cable not connected</td>
</tr>
<tr>
<td></td>
<td>OFF</td>
<td>ON</td>
<td>Sensor not connected or not detected</td>
</tr>
<tr>
<td>CDR DICOM is running</td>
<td>ON</td>
<td>Blinking every ½ - 1½ seconds</td>
<td>Sensor connected</td>
</tr>
<tr>
<td>Changing Sensors</td>
<td>(CDR DICOM not running)</td>
<td>OFF</td>
<td>Sensor not connected or not detected</td>
</tr>
<tr>
<td></td>
<td>(CDR DICOM is running)</td>
<td>ON</td>
<td>Sensor connected</td>
</tr>
</tbody>
</table>

Table 2. CDR USB Remote HS LED Indications
5. Operation

5.1. Operating the Device

5.1.1. Power On

1. Turn on the PC workstation used with imaging applications.

2. Connect the “B-type” end of the USB cable to the CDR USB Remote HS.

3. Connect the “A-type” end of the USB cable to the PC workstation.

4. The amber LED on the CDR USB Remote HS blinks momentarily (if the Sensor is connected and detected), indicating that power is applied to the CDR USB Remote HS, effectively turning the device on.

5. Continue with Section 5.2 for step-by-step instructions on acquiring X-ray images with CDR DICOM software.

5.1.2. Power Off

1. Disconnect the USB cable from either the CDR USB Remote HS or the PC workstation.

2. Power is removed from the CDR USB Remote HS, effectively turning the device off.
5.2. Using CDR USB Remote HS with CDR DICOM

NOTE: Refer to the CDR DICOM User Guide, Sirona Dental P/N 1051047, for detailed information on the use and operation of CDR DICOM software.

**STEP 1**

Start CDR DICOM from the Windows **Start** button or by clicking the shortcut to CDR DICOM for Windows on your desktop.

**STEP 2**

When the CDR exam window appears, click on **New Exam** under the **File** menu or just click the **New Exam** button on the toolbar.

**STEP 3**

A. Enter the appropriate patient information and then click on **X-ray Series**. You may use a pre-defined intraoral series or create a new one.

B. To customize an X-ray series for the current exam, click **Edit Series**, which opens the Edit Viewset dialog box. (Re-usable, customized series can be created at the **Series > New Intraoral Series** menu.)

C. The numbers in the text boxes correspond to how many target frames (view boxes) are included in this series. You can edit the numbers, creating a series customized with the views you wish to include.

D. Enter a name for this X-ray series. Click **OK**.

**STEP 4**

A. Slide an appropriately-sized sheath over the Sensor. Select a CDR positioning holder specific to the intraoral area intended for exposure and apply it to the sheath. Attach positioning arm and aiming ring, as needed.

B. Verify the X-ray exposure settings. Proper technique factors depend on several variables, among them, the type of X-ray tube, the anatomy of the patient, and the location of the Sensor in the oral cavity.
**STEP 5**

A. If your acquisition mode is set to AutoTake, the first empty view box in the exam is pre-selected and flashes green (default setting). Skip ahead to step 7.

B. If your acquisition mode is set to manual, select an empty target frame that corresponds to the Sensor’s location in the patient’s mouth. When the view box is highlighted, click on it again. If you are using a serial footpedal, press the amber pedal.

**STEP 6**

The system is ready to acquire an X-ray image. A “Please Wait” message may appear momentarily.

**STEP 7**

A. In AutoTake mode, activate the X-ray source. The message, “Reading Image from Sensor” appears momentarily.

B. In manual mode, activate the X-ray source when the message, “Waiting to take X-ray” appears.

C. The acquired image appears automatically in the zoom or exam window, depending on system settings.

**STEP 8**

A. In AutoTake mode, the next empty view box in the series sequence is selected. To acquire the next X-ray image, repeat this procedure starting at Step 7.

B. In manual mode, close the exam window. To acquire the next X-ray image, repeat this procedure starting at Step 5.
5.3. **Acquiring X-ray Images with the Footpedal**

Serial footpedals (Schick P/N B2501100; PDCO P/N 07-0410100) can be used to navigate view boxes inside a patient exam and to control the capture of X-ray images. Refer to the following table for information.

Table 3. Footpedal Actions

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use Pedal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a view box</td>
<td>Green</td>
</tr>
<tr>
<td>Take an X-ray (manual mode)</td>
<td>Amber</td>
</tr>
</tbody>
</table>

5.4. **Acquiring X-ray Images with Keyboard Shortcuts**

Intraoral image acquisition can be also accomplished through the use of shortcut keys. Refer to the following table for information.

Table 4. Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Desired Action</th>
<th>Use Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a view box</td>
<td>[Spacebar] or [Page up] or [Page down]</td>
</tr>
<tr>
<td>Take an X-ray (manual mode)</td>
<td>[Insert] or [Enter]</td>
</tr>
</tbody>
</table>
6. Protective Measures

6.1. Cleaning

**IMPORTANT!** Be sure to disconnect the CDR USB Remote HS from the Sensor and the USB cable before performing any cleaning procedures.

To clean the CDR USB Remote HS, use either of the following solutions and observe the precautions noted below. Do not soak or immerse the CDR USB Remote HS and be sure to dry it completely afterwards.

- Mild soap and water
- Isopropyl alcohol (70%)

Clean the surface of the CDR USB Remote HS by moistening a soft cotton swab dipped in either of the cleaning solutions listed. Gently wipe the surface from end-to-end in straight lines without applying pressure. Do not allow any amount of liquid to enter the device through the USB cable or Sensor cable connectors.

After cleaning the surface of the CDR USB Remote HS, use a clean lint-free cloth to dry the device, as needed, until the surface is clean.

To avoid cross contamination, follow the cleaning instructions provided by your computer manufacturer and implement them as part of your normal routine for ensuring proper sterilization and disinfectant of tools and other devices in your dental practice.
7. Maintenance

7.1. Visual Inspection

Like all electrical equipment, the CDR USB Remote HS requires not only correct use, but also visual inspection prior to operation, and routine checks at regular intervals. These precautions will help ensure that the CDR USB Remote HS operates accurately, safely, and efficiently.

There are no user-serviceable components in the CDR USB Remote HS. However, before operating the system, users shall check it for any signs of physical damage or defect. If detected, contact your local distributor of Sirona Dental products for further instructions.

7.2. Periodic Maintenance

Periodic maintenance is performed as needed, but at least once a month. It consists of various checks performed by the operator or by a qualified service technician.

- Check that the labels are intact, readable, and adhere well to the surfaces on which they are positioned
- Check that all of the cables that connect to the CDR USB Remote HS are undamaged
- Check that there is no external damage to the CDR USB Remote HS which could compromise its ability to operate safely
Appendix A. Reference

A-1. Removal and Replacement Procedures

There are no user-serviceable parts in the CDR USB Remote HS. Should you experience problems with the CDR USB Remote HS, please contact your local distributor of Sirona Dental products. In the United States, Sirona Dental products are available exclusively through Patterson Dental Supply, Inc. Call your local Patterson representative, local Patterson branch, or 1-800-873-7683 for more information.

A-2. Summary of Specifications

CDR USB Remote HS is ETL-certified and complies with safety standards listed below.

Table 5. Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC/Safety</td>
<td>CAN/CSA C22.2 No.601.1-M90 Medical Electrical Equipment Part 1: General Requirements for Safety</td>
</tr>
<tr>
<td></td>
<td>EC93/42/EEC Medical Device Directive</td>
</tr>
<tr>
<td></td>
<td>IEC60601-1 Medical Electrical Equipment Part 1: General Requirements for Safety</td>
</tr>
<tr>
<td></td>
<td>UL60601-1 Medical Electrical Equipment: General Requirements for Safety</td>
</tr>
<tr>
<td>Classification</td>
<td>Class II, Type BF equipment</td>
</tr>
<tr>
<td></td>
<td>Not Category AP equipment</td>
</tr>
<tr>
<td></td>
<td>Not Category APG equipment</td>
</tr>
<tr>
<td>Mode of Operation</td>
<td>Equipment is intended for continuous use</td>
</tr>
<tr>
<td>Additional Notes</td>
<td>Equipment is not suitable for use in the presence of a Flammable Anesthetic Mixture with Air or with Oxygen or Nitrous Oxide.</td>
</tr>
<tr>
<td>Supply Voltage</td>
<td>+5V DC (derived for PC USB port)</td>
</tr>
<tr>
<td>Supply Current</td>
<td>250 mA</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>1.25W</td>
</tr>
<tr>
<td>Dimensions</td>
<td>3.25 x 2.3 x 0.9 in. (1.28 x 0.91 x 0.35 cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1.8 oz. (50g)</td>
</tr>
<tr>
<td>Transport and Storage Conditions</td>
<td>Ambient temperature range: -40° F (-40° C) to 158° F (+70° C)</td>
</tr>
<tr>
<td></td>
<td>Relative humidity range: 10 to 100%, including condensation</td>
</tr>
<tr>
<td></td>
<td>Atmospheric pressure range: 500 hPa to 1060 hPa</td>
</tr>
</tbody>
</table>
### Operating Conditions

<table>
<thead>
<tr>
<th>Item</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature range</td>
<td>50°F (+10°C) to 104°F (+40°C)</td>
</tr>
<tr>
<td>Relative humidity range</td>
<td>less than 75%</td>
</tr>
<tr>
<td>Atmospheric pressure range</td>
<td>700 hPa to 1060 hPa</td>
</tr>
</tbody>
</table>

### Restricted service statement

Unless otherwise specified, this unit should be serviced only by the manufacturer. It contains no user-serviceable parts.

### External power supply

None (power supplied via USB)

### Maximum cable length

5 m (5.5 yds)

---

**A-3. Leakage Current Statement**

CDR USB Remote HS complies with the leakage current requirements of IEC 60601-1-1 safety standard. Variations, however, may exist in the construction of computers to which the CDR USB Remote HS is connected. Customers are advised to have a qualified electrician perform a leakage test on their equipment before using the CDR USB Remote HS.
A-4. EMC Tables

The following tables provide CDR USB Remote HS compliance information to electromagnetic compatibility (EMC) and electromagnetic immunity (EMI) standards. To ensure conformance, the customer or user must use the CDR USB Remote HS in environments that are consistent with these standards.

The USB cable required with the CDR USB Remote HS device must also comply with the same standards. The operation of the CDR USB Remote HS has been independently tested using USB cables identified in Section 2.1. Compliance to EMC and EMI standards cannot be guaranteed by the use of alternate cables.

Table 6. Guidance and Manufacturer's Declaration - Electromagnetic Emissions

PLEASE NOTE: The CDR USB Remote HS is intended for use in the electromagnetic environment specified below. The customer or user of the CDR USB Remote HS must ensure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions Test</th>
<th>Compliance</th>
<th>Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions</td>
<td>Group 1</td>
<td>The CDR USB Remote HS uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF emissions</td>
<td>Class B</td>
<td>The CDR USB Remote HS is suitable for use in all establishments including domestic establishments and those directly connected to the public low-voltage supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td>Class D</td>
<td></td>
</tr>
<tr>
<td>Harmonic emissions</td>
<td>Class D</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/</td>
<td>Complies</td>
<td></td>
</tr>
<tr>
<td>flicker emissions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEC 61000-3-3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 7. Guidance and Manufacturer's Declaration - Electromagnetic Immunity

PLEASE NOTE: The CDR USB Remote HS is intended for use in the electromagnetic environment specified below. The customer or user of the CDR USB Remote HS must ensure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharge (ESD)</td>
<td>±6 kV contact</td>
<td>±6 kV contact</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.</td>
</tr>
<tr>
<td>IEC 61000-4-2</td>
<td>±8 kV air</td>
<td>±8 kV air</td>
<td></td>
</tr>
<tr>
<td>Electrical fast transient/burst</td>
<td>±2 kV for power supply lines</td>
<td>±2 kV for power supply lines</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-4</td>
<td>±1 kV for input/output lines</td>
<td>±1 kV for input/output lines</td>
<td></td>
</tr>
<tr>
<td>Surge</td>
<td>±1 kV differential mode</td>
<td>±1 kV differential mode</td>
<td>Mains power quality should be that of a typical commercial or hospital environment.</td>
</tr>
<tr>
<td>IEC 61000-4-5</td>
<td>±2 kV common mode</td>
<td>±2 kV common mode</td>
<td></td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines</td>
<td>&lt; 5% $U_T$ ($\geq 95%$ dip in $U_T$) for 0.5 cycle</td>
<td>&lt; 5% $U_T$ ($\geq 95%$ dip in $U_T$) for 0.5 cycle</td>
<td>Mains power quality should be that of a typical commercial or hospital environment. If the user of the CDR USB Remote HS requires continued operation during mains interruptions, it is recommended that the PC workstation to which the CDR USB Remote HS is connected be powered from an uninterruptible power supply or battery. NOTE: $U_T$ is the AC mains voltage prior to application of the test level.</td>
</tr>
<tr>
<td>IEC 61000-4-11</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td>40% $U_T$ (60% dip in $U_T$) for 5 cycles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td>70% $U_T$ (30% dip in $U_T$) for 25 cycles</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt; 5% $U_T$ ($\geq 95%$ dip in $U_T$) for 5 sec</td>
<td>&lt; 5% $U_T$ ($\geq 95%$ dip in $U_T$) for 5 sec</td>
<td></td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field</td>
<td>±3 A/m</td>
<td>±3 A/m</td>
<td></td>
</tr>
<tr>
<td>IEC 61000-4-8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Conducted RF</td>
<td>3 Vrms</td>
<td>3 Vrms</td>
<td>Portable and mobile RF communication equipment should be used no closer to any part of the CDR USB Remote HS, including its cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter. Recommended separation distance: $d = 1.2 \sqrt{P}$</td>
</tr>
<tr>
<td>IEC 61000-4-6</td>
<td>150 kHz to 80 MHz</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Immunity Test

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
<th>Guidance</th>
</tr>
</thead>
</table>
| Radiated RF   | IEC 61000-4-3        | 3 V/m 80 MHz to 2.5 GHz | 3 V/m | d= 1.2 \( \sqrt{P} \) for 80 MHz to 800 MHz  
d= 2.3 \( \sqrt{P} \) for 800 MHz to 2.5 GHz  
Where \( P \) is the maximum output rating of the transmitter in watts (W) according to the transmitter manufacturer and \( d \) is the recommended separation in meters (m).  
Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.  
Interference may occur in the vicinity of equipment marked with the following symbol. |

**NOTE 1:** At 80 MHz and 800 MHz, the higher frequency range applies.  
**NOTE 2:** These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

---

\( ^a \) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the CDR USB Remote HS is used exceeds the applicable RF compliance above, the CDR USB Remote HS should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as reorienting or relocating the CDR USB Remote HS.

\( ^b \) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.
Table 8. Recommended Separation Distance Between Portable and Mobile RF Communications Equipment and the CDR USB Remote HS

PLEASE NOTE: The CDR USB Remote HS is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or user of the CDR USB Remote HS can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the CDR USB Remote HS as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of the transmitter (W)</th>
<th>Separation distance according to the frequency of the transmitter (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>150 kHz to 800 MHz</td>
</tr>
<tr>
<td></td>
<td>(d = 1.2 \times \sqrt{P})</td>
</tr>
<tr>
<td></td>
<td>800 MHz to 2.5 GHz</td>
</tr>
<tr>
<td></td>
<td>(d = 2.3 \times \sqrt{P})</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td></td>
<td>0.23</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
</tr>
<tr>
<td></td>
<td>0.73</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td></td>
<td>2.30</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
</tr>
<tr>
<td></td>
<td>7.3</td>
</tr>
<tr>
<td>100</td>
<td>12.0</td>
</tr>
<tr>
<td></td>
<td>23.00</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance \(d\) in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where \(P\) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1: At 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects, and people.
Appendix B. Troubleshooting Tips

B-1. Introduction

In the event you experience a problem with the CDR USB Remote HS, refer to the table of troubleshooting tips found on this page. If the problem persists, please contact your local distributor of Sirona Dental products.

In the United States, Sirona Dental products are available exclusively through Patterson Dental Supply, Inc. Call your local Patterson representative, local Patterson branch, or 1-800-873-7683 for more information.

B-2. Troubleshooting

Please refer to Section 3.4 for details on using the CDR USB Remote Utility, including information on how to perform the Sensor Emulator Test, or refer to the following table for additional information.

Table 10. Troubleshooting Table

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CDR USB Remote HS LEDs do not illuminate when the imaging application is running.</td>
<td>Check that the USB cable is plugged correctly into the Remote. Check that the Remote has been installed and is listed in the Windows Device Manager. Reset the hardware by unplugging the USB cable from the Remote and reconnecting it.</td>
</tr>
<tr>
<td>2</td>
<td>Either the green LED (by itself) or both LEDs (amber and green) are on continuously before the imaging application is running.</td>
<td>Hardware error. Unplug the USB cable from the Remote and reconnect it. Contact Customer Support if the problem persists.</td>
</tr>
<tr>
<td>3</td>
<td>Amber LED is continuously on (whether the imaging application is running or not).</td>
<td>Check that the Sensor is connected properly, or use another sensor.</td>
</tr>
<tr>
<td>4</td>
<td>Green LED does not illuminate when the imaging application is started.</td>
<td>USB communication error. Open the Windows Device Manager to ensure that the device was installed correctly.</td>
</tr>
<tr>
<td>5</td>
<td>Amber LED blinks once every 3 seconds.</td>
<td>The firmware in the Remote has been corrupted, or the Remote is damaged. Start the CDR USB Remote HS Utility and reprogram the Remote, or use another Remote.</td>
</tr>
</tbody>
</table>
## Index

### A
- Acquiring X-ray Images with Footpedal, 19
- Acquiring X-ray Images with Shortcuts, 19
- Always Use Sheaths with Sensors, v

### C
- Cable Connections, 3
- CDR USB 2 Remote
  - Check before Using, iii
  - Cleaning, 20
  - Connecting Cables, 3
  - Description of, 1
  - Electromagnetic Emissions, 24
  - Electromagnetic Immunity, 25
  - Hardware Setup, 3
  - Holder Installation, 4
- LEDs, 15
- Maintenance, 21
- Operation, 16
- Periodic Maintenance, 21
- Picture of, ix
- Protective Measures, 20
- Recommended Separation Distance Between Portable and Mobile RF Communications Equipment, 27, 28
- Software Setup, 6
- Table of LED Indications, 15
- Using the Device with CDR DICOM, 17
- Visual Inspection, 21
- Cleaning, 20

### D
- Dentists or Authorized Designees Only Are Permitted to Operate the System, v
- Do Not Touch Exposed Connectors, iii

### E
- EMC Tables, 24
- Ensure CDR USB 2 Remote Operates Optimally, iv
- Explanation of Symbols, vi

### F
- Footpedal, 19

### H
- Hardware Setup, 3

### K
- Keyboard Shortcuts, 19

### L
- Leakage Current Statement, 23
- LED Indicators, 15

### M
- Maintenance, 21

### O
- Operate CDR USB 2 Remote as Directed, iii
- Operating the CDR USB 2 Remote, 16

### P
- Proper System and PC Workstation Installation and Operation, iv
- Protective Measures, 20

### R
- Recommended Procedures, iii
- Reference Information, 22
- Removal and Replacement Procedures, 22
- RF Interference, iv

### S
- Safety Issues
  - Always Use Sheaths with Sensors, v
  - Check CDR USB 2 Remote before Using, iii
  - Do Not Touch Exposed Connectors on Non-Medical Equipment and the Patient at the Same Time, iii
  - Ensure CDR USB 2 Remote Operates Optimally, iv
  - Items Not Part of the System, iii
  - Only Dentists or Authorized Designees Are Permitted to Operate the System, v
  - Operate the CDR USB 2 Remote as Directed, iii
  - Proper System and PC Workstation Installation and Operation, iv
  - Recommended Procedures, iii
  - RF Interference Considerations, iv
- Software Setup, 6
- Summary of Specifications, 22

### T
- Troubleshooting Introduction, 28
- Troubleshooting Table, 28

### U
- USB Cable
  - Picture of, 3

### W
- Waste Electrical and Electronic Equipment (WEEE), vii